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INTRODUCTION [1] 

Tuberculosis is an infectious disease considered as a global epidemic [2]. The tuberculosis 

infection caused by a type of bacterium called Mycobacterium tuberculosis which is an 

airborne pathogen transmitted among a human which infects macrophages in the lungs. 

Mycobacterium tuberculosis was first identified by Robert Koch in 1882 and it is curable and 

preventable. Tuberculosis is the most attractive areas of research because it is the second 

major cause of death due to an infectious disease in adults worldwide. [2] 

LATEST STATUS OF TB EPIDEMIC [4] 

TB occurs in every part of the world. Thirty countries of the world have the highest TB 

burden, among top eight ranking countries are India, china, Indonesia, Philippines, Pakistan, 

Nigeria, Bangladesh and south Africa. This gravity of situation is understood from the report 

published in 2020 by WHO, according to this 43% of the largest number of new TB cases 

occurred in south-east region, followed by 25% of new cases occurred in African region and 

western pacific with 18% new cases. This alarming situation exposes 0.22 billion people will 

have acquire TB and 79 million people could die due to TB by the year 2030[3]. 

MYCOBACTERIUM TUBERCULOSIS [3] 

The mycobacterium tuberculosis is under the genus of mycobacterium in which the 

most important species are mycobacterium tuberculosis (causing TB) and mycobacterium 

leprae (causing leprae). The mycobacterium tuberculosis complex includes the strains of 

M.tuberculosis, M.africanum, M.bovis. These species having 99.9% similarity at nucleotide 

level and differentiate in terms of tropisms, phenotypes and pathogenicity. Mycobacterium 

bovis is the type of mycobacterium most commonly found in cattle and causes TB infections 

to humans. 

 

Figure 01: classification of mycobacterium tuberculosis 
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HISTORY OF TUBERCULOSIS: [3] 

❖ Tuberculosis was known to exist since antiquity. But until 1820, it was 

not identified as a single disease. The name tuberculosis was coined by 

‘J.L.Schonlein’. 

❖ In the earlier times, Tuberculosis was commonly known by the terms 

such as Phthisis, Pulmonalis and White Plague. 

❖ Pulmonary tuberculosis was called as Phthisis which means Consumption 

in Greek. The common term consumption was used to denote the severe weight 

loss produced as a result of this deadly disease. 

❖ In 1882, Robert Koch identified the organism causing the disease and 

described it as Mycobacterium tuberculosis. 

❖ In the 19th and early 20th centuries, TB was more common among the 

urban poor and the major concern was on the prevention and treatment of the 

disease. 

❖ Due to this, medical council research initially focused on the tuberculosis 

research. 

CAUSATIVE ORGANISM: 

                Mycobacterium tuberculosis is gram positive, non-motile, non-spore forming and 

aerobic bacteria. The curved intracellular rod size 0.2-0.6µm width and 1.0-10µm long. Their 

cell wall contains mycolic acid rich long chain glycolipids that protect mycobacteria from 

cell lysosomal attack and also retain red basic fuchsine dye after acid rinsing (acid-fast stain). 

 

 

   Figure 02: Acid-fast staining of Tb bacteria 
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HIERARCHICAL CLASSIFICATION OF MYCOBACTERIUM TUBERCULOSIS 

Table 01: Hierarchical classification of Mycobacterium tuberculosis 

Domain Bacteria 

Phylum 
Actinobacteria 

Class 
Actinobacteria 

Order 
Actinomycetales 

Family 
Mycobacteriaceae 

Genus 
Mycobacterium 

Species 
Mycobacterium tuberculosis 

 

 

TRANSMISSION OF TUBERCULOSIS [3] 

➢ Mycobacterium tuberculosis is an airborne pathogen. 

➢ Transmitted among humans which infect macrophages in the lungs. 

➢ Two possible outcomes, 

1. T-cell mediated adaptive immunity enabling the host to eradicate the bacilli at 

the initial site of infection. The bacilli may further multiply within in the 

macrophages for 7-21 days. 

2. Alveolar macrophages engulf the bacteria nonspecifically but not activated to 

kill them. 

➢ Failure of adaptive immunity leads to uncontrolled growth of an organism. 

➢ Subsequent spread through the lymphatic system to secondary sites. 

➢ If not treated it kills more than 50% of the people. 



Introduction 

 

DEPARTMENT OF PHARMACEUTICAL CHEMISTRY, COP, MMC. Page 4 
 

 

Figure 03[40]: Transmission of Tuberculosis 

 

CLASSIFICATION OF TUBERCULOSIS: [5] 

ACTIVE TUBERCULOSIS: 

Active tuberculosis is a condition in which Mycobacterium tuberculosis actively causes 

infection and is contagious. The symptoms of active TB vary depending on whether it is 

pulmonary tuberculosis or extra pulmonary tuberculosis. 

LATENT TUBERCULOSIS: 

Latent Tb is a condition in which mycobacterium tuberculosis bacteria are dormant in the 

body asymptomatically. In this state patient infected with TB but doesn’t have active TB 

condition. 10% people will develop active Tb at a later their life. 

MULTIDRUG RESISTANT TUBERCULOSIS: 

Resistance to first line anti-tuberculosis drug like isoniazid and rifampicin is known as MDR-

TB. 

EXTENSIVELY DRUG RESISTANCE TUBERCULOSIS: 

Resistance to isoniazid, rifiampicin, fluroquinolones and one of the second line drugs being 

capable of being injected is known as XDR-TB. 
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MEDICAL HISTORY OF CURRENT TB CHEMOTHERAPHY [2] 

➢ Treatment of effective chemotherapy for tuberculosis began in 1940s with the 

discovery and use of streptomycin and para-aminosalicylic acid. 

➢ The first randomized controlled study of STR treatment for TB by the BMRC 

(BRITISH MEDICAL RESEARCH CUNCIL) showed that streptomycin was 

effective in short-term but develop resistance for the long-term use. 

➢ Later the Isoniazid was discovered and the combined triple drug therapy was 

introduced. 

➢ In 1993, the WHO declared TB as a global emergency. If only a single drug used for a 

long period of time resistant mutant will emerge, to avoid this combination of drug 

therapy used. 

➢ First two months of tuberculosis considered as intensive phase followed by four 

months considered as continuous phase. 

➢ The hope of eradication of TB arises with the development of an antibiotic 

Streptomycin in the year 1946. But, the rise of drug resistant strains in 80’s has 

increased the need for newer therapeutic agents. 

➢ Development of resistance to the drugs used in the TB treatment regimen 

resulted in the emergence of MDR (Multi-Drug Resistant) TB and XDR 

(Extensively Drug Resistant) TB. 

➢ Co-infections like HIV, COVID-19 and the metabolic disorders like Diabetes 

worsens the body’s natural immunity and renders the management of 

tuberculosis very challenging. 

 

CELL WALL STRUCTURE: [6] 

The structure and composition of the cell wall is unique. It contains a 

mycolyl- arabinogalactan-peptidoglycan complex which maintains the cellular 

integrity and is responsible for the virulence of the organism. The cell organelles 

are surrounded by the cytoplasmic membrane and then the peptidoglycan layer. 

The arabinogalactan layer connects the peptidoglycan layer to the outer 

mycomembrane composed of the mycolic acids. 
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Figure 04[39]: Cell wall structure of Mycobacterium Tuberculosis 

A. Peptidoglycan layer: 

It comprises of the short peptides and glycan strands that are made up of 

N-acetylglucosamine (GlcNAc) and N-acetylmuramic acid (MurNAc) 

residues linked by β-1→4 bonds. A part of the MurNAc molecules is oxidized 

to N-glycolyl muramic acid which is also responsible for the cell wall integrity 

and resistance shown by the bacterium towards the lysozyme and the β-lactam 

antibiotics. A rigid cell wall is produced by cross linking the peptidoglycan 

chains. 

 

B. Arabinogalactan layer: 

 

It is a highly branched heteropolysaccharide composed of galactose 

and arabinose in a furanoid form. It is covalently linked with the MurNAc 

residues of the peptidoglycan layer and connects it with the outer mycolic acid 

membrane layer. 

C. Mycomembrane: 

 

It comprises 50% dry weight of the cell wall. Mycolic acids are the 

unique α- branched lipids which form the homogenous external membrane. They 

are the highly hydrophobic long chain fatty acids which form a barrier to the 

hydrophilic drug molecules by forming a lipid shell around the organism and it 

also acts as a significant determinant of virulence. The external layer maintains the 

host-symbiont relationship as it contains trehalose monomycolate (TMM) and 

trehalose dimycolate (TDM/ Cord factor). 
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Advantages of the high concentration of lipids: 

✓ The lipid rich outer cell layer makes the organism impermeable to certain 

stains and dyes. 

✓ It prevents the antibiotics from entering into the cell. 

✓ It resists osmotic lysis and killing by acidic and alkaline compounds. 

✓ It prevents the organism from the lethal oxidation and allows surviving 

even inside the macrophages. 

ANTI-TB TREATMENT: 

In India, Revised National TB Control Program (RNTCP) was 

initiated in 1997 to provide proper treatment guidelines across the entire nation. 

Now, it is updated as RNTCP- II to provide services for TB/HIV & MDR-TB. It 

utilizes the Directly Observed Treatment Short course (DOTS) strategy 

recommended by the WHO in the mission against Tuberculosis infection. It carries 

out the five years TB National Strategic Plan (NSP) by the Government of India. 

The national goal announced in 2017 was ‘Elimination of TB in India by 2025’. 

In 2020, RNTCP was rechristened as National Tuberculosis Elimination 

Programme (NTEP). 

 

Table 02: Anti-TB drugs for Drug susceptible Tuberculosis 

 

Drug Susceptible TB 

Intensive phase 
Continuation Phase 

2 months 
4 months 

Isoniazid, Rifampicin, 

Ethambutol and Pyrazinamide. 

 

Isoniazid and Rifampicin. 
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Table 03: Anti-TB drugs for Multi-Drug Resistant Tuberculosis 

Drug Resistant TB (MDR TB) 

Intensive Phase Continuation Phase 

4 – 6 months 5 months 

Ethambutol/Pyrazinamide, Clofazimine/high 

dose of Isoniazid, Gatifloxacin/Moxifloxacin, 

Kanamycin/Amikacin 

Ethambutol/Pyrazin

amide, Clofazimine, 

Gatifloxacin/Moxifl

oxacin 

 

CO – INFECTION: 

                   Risk of developing Tuberculosis is more in the Immunocompromised 

individuals. HIV/AIDS infection makes an individual more immunocompromised. A 

person with HIV Infection is 16.27 times more vulnerable to develop the TB infection 

than the non-HIV individuals. The risk of death is also twice in these cases. The 

progress of one disease got speeded by the other. 

Providing treatment for both the infection i.e., HIV- Anti RetroViral 

therapy (ART) & Anti-TB therapy at a time results in several problems such as, 

✓ Drug-drug interactions 

✓ Cumulative drug toxicities 

✓ High pill burden 

✓ The Immune Reconstitutive Inflammatory Syndrome (IRIS). 

                At present, the pandemic COVID-19 threatens to reverse the progress 

made towards the Global TB targets. Due to the national lockdown, there were 

many restrictions in face to face assessments of patients & infection control 

strategies which resulted in drop in the new active TB case diagnosis, outpatient 

settings and monitoring & supply of Anti-TB medications. 
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UNMET NEEDS OF CURRENT TUBERCULOSIS TREATMENT OF FIRST 

LINE THERAPY: [8] 

The first line TB treatment of standaridized short-course chemotherapy, rifampicin and 

isoniazid was presecribed for 6 months. Later supplemented with pyrazinamide and 

ethambutol for following 2 months for drug-susceptible TB. 

 

1. Drug-drug interaction due to high enzyme induction of cytochrome p450. 

2. The emergence of drug resistance tuberculosis. 

3. Adverse effects from many of the existing drugs. 

4. Current TB drugs not active against MDR and XDR tuberculosis. 

5. Treatment of latent TB infection. 

 

WHY NEED TB NEW DRUG? [7] 

✓ Need of novel drug combinations 

✓ Reducing pill burden 

✓ Suitable pediatric formulation not available 

✓ Need for treating HIV-TB co infected patients 

✓ Available in low price 

✓ Shorten treatment time 

✓ To improve the MDR TB treatment 

 

 

 

 

 

 

 

 

 

 

 



Introduction 

 

DEPARTMENT OF PHARMACEUTICAL CHEMISTRY, COP, MMC. Page 10 
 

VARIOUS ENZYME TARGETS: [11] 

Some of the important enzymes involved in the various cellular processes and remained as 

the attractive drug targets in the Mycobacterium tuberculosis are listed below; 

Table 04: Critical Enzymes in Mycobacterium tuberculosis 

ENZYMES FUNCTION 

Glucosamine-6-phosphate Synthase Peptidoglycan layer synthesis 

Phosphoglucosmaine mutase Peptidoglycan layer synthesis 

Transpeptidases Cross linking of peptidoglycan chains 

Aminoacyl t-RNA synthetases Menaquinone synthesis 

Fatty acyl-AMP ligases Lipid metabolism 

Fatty acyl-coA ligases Lipid metabolism 

Non-ribosomal peptide synthetases Mycobactin synthesis 

Succinate dehydrogenase Energy production 

Glutamine synthetase Nitrogen metabolism 

ATP synthase ATP production 

Rhamnosyl transferase Arabinogalactan synthesis 

α-manno pyranosyl transferase Phosphatidyl-myo-inositol 

mannoside synthesis 

Fatty acid synthase Mycolic acid synthesis 

 

For the current research work, ATP synthase was chosen as a drug target for in-silico 

and in-vitro studies



Enzyme profile 

 

DEPARTMENT OF PHARMACEUTICAL CHEMISTRY, COP, MMC. Page 11 
 

BIOLOGICAL TARGET 

ENZYME PROFILE- ATP SYNTHASE [14] [15][16][17][18] 

                  

                   ATP SYNTHASE is an essential enzyme in the obligate aerobic mycobacterium genus. 

ATP synthase is membrane-protein complex which is responsible for the production of ATP. It 

consists of two motor like domains such as F1 motor and F0 motor. ATP driven F1 domain 

composed of five subunits (α3β3γδε) and it is located in the cytoplasm. Proton-driven F0 domain is 

embedded in the membrane with three subunits (a1b2c10-15). It is an omnipresent enzyme. 

Mycobacterium can survive by the production of energy molecule ATP by ATP synthase. 

                  Membrane bound ATP synthase converts ADP to ATP by utilizing the transmembrane 

electrochemical ion (H+ or Na+) gradient. The c subunit of F0 ATP synthase has ion binding sites 

which transport ions across the membrane and generate the power for ATP synthesis. The catalytic 

site present in the F1 part of ATP synthase produces ATP by combining ADP and pi. 

                Since, ATP synthase is essential for the optimal growth of Mycobacterium tuberculosis. It 

is a key enzyme involved in the energy metabolism. So it is an important drug target for developing 

novel molecules against the enzyme which can be a promising drug candidate in the anti-tuberculosis 

therapy. Mycobacterium ATP synthase inhibition of energy metabolism has potential to shorten the 

treatment time. 

 

Figure 05: Secondary structure of ATP SYNTHASE (PDB ID– 7JG
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BASIC HETERONUCLEAR SCAFFOLD [19][22] 

 

Heterocyclic compounds are those which contain at least one non carbon hetero atom in 

their ring structure. Many of the drugs contain heterocyclic ring in their structure which 

have proved to be efficient in their pharmacological activity. 

Indole, a bicyclic heteroarene with the Molecular formula C8H7N is formed by 

the fusion of the benzene ring with the pyrole ring. Substituted indoles are the structural 

elements and synthetic precursors of many compounds. Some of them include tryptophan- 

derived tryptamine alkaloids, psilocybin (naturally occurring psychedelic drug), Auxin 

(plant hormone), Indomethacin (Anti-inflammatory drug), Pindolol (Beta-blocker).,etc., 

Isatin (1H-indole-2,3-dione - a diketo derivative of indole) also known as 

Tribulin, Indenedione or Indolequinone is a substituted indole with two carbonyl groups at 

2nd & 3rd positions. In 1840, it was obtained as an oxidation product of Indigo dye by Otto 

Linne Erdman & Auguste Laurent. In humans Isatin is found as a metabolic derivative 

of the Hormone Adrenaline and Isatin derivatives also occur in plants. 

Isatin undergoes numerous substitution (N-substitution, Electrophilic aromatic 

substitution at Phenyl ring), Addition (Nucleophilic addition at Carbonyl groups), 

Oxidation, Reduction and Ring expansion reactions. Isatin is one of the valuable building 

blocks in organic synthesis, due to its unique reactivity. They have a wide range of 

applications in various fields. Substituted and unsubstituted isatins can be synthesized by 

Stolle and Sandmeyer Methodologies. N-substituted isatins can also be synthesized by 

simple oxidation procedures using suitable oxidizing agents. 

         Biological activities of Isatin comprises, 

 

• Anti-cancer 

• Anti-bacterial 

• Anti-diabetic 

• Anti-fungal 

• Anti-tubercular 

• Anti-malarial 
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• Anti-inflammatory 

• Anti-anxiety 

• Anti-oxidant  

 

 

➢ Since Isatin has wide range of pharmacological activities, it was chosen as a 

basic heteronuclear scaffold in the present study, for designing novel molecules 

against the enzyme target. 

➢ Structural modifications were performed on the nucleus to get novel isatin 

derivatives. 
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REVIEW OF LITERATURE  

LITERATURES RELATED TO THE TUBERCULOSIS AND ITS MANAGEMENT: 

 

1. Chaw, Liling et al., (2020)
 [24]

 assessed the global TB burden and the focus of majority of 

Countries on the Latent tuberculosis infection by performing a literature survey. 

2. Canetti et al., (2020)
 [26]

 briefly outlined the complication of Anti-TB treatment in the HIV 

co-infected patients and the new drug regimen for the co-treatment was clearly explained. 

3. Migliori, G. Battista et al., (2020)
 [43]

 evaluated the risks associated with the treatment of 

Drug-resistant tuberculosis and their clinical management. 

4. Daley, L.Charley (2019)
 [47]

 has outlined the current approaches to control tuberculosis and 

the several gaps needed to be closed for the eradication of the disease. 

5. Pezella, A.Thomas (2019)
 [28]

 highlighted the epidemiology of TB since ancient times and the 

evolution of the Tuberculosis treatment. 

6. Adeeb shehzad, Gauhar Rehman et al., (2013)
 [7]

 have explained the challenges in the 

development of drugs for the treatment of tuberculosis. 

7. Beena and diwan s. rawat (2013)
 [3]

 have reported the overall critical view of Anti-

tuberculosis drug research. 

8. Gwendlyn a. mariner et al., (2011)
 [2]

 reported the medicinal chemistry of tuberculosis 

chemotherapy. 

9. Shruti Rawal, Richa Sood, Nipun Mahajan et al., (2010)
 [42]

 assessed the current status and 

future prospects for tuberculosis. 

LITERATURES RELATED TO THE MYCOBACTERIUM TUBERCULOSIS DRUG 

TARGETS 

 

10. Shetye, Gauri et al., (2020)
 [25]

 have elaborated on the novel enzyme targets in the 

Mycobacterium      tuberculosis that are necessary for the survival of the organism. 

11. Shanib Bhat, Zubair et al., (2018) 
[39]

 have summarized the current TB regimen and the 

various drug targets exploited in the organism for new drug discovery. 

12. Takushi kaneko et al., (2011)
 [43]

 have reported the novel targets and novel modes of TB 

drug development. 

13. Zhenkum ma, Christian lienhardt et al., (2010)
 [44]

 assessed the present tuberculosis 

treatment and their unmed needs. 
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14. Sharmila anishetty, mrudula pulimi et al., (2005) [45] have detailed the potential drug 

targets in mycobacterium tuberculosis through metabolic pathway analysis. 

 

LITERATURES RELATED TO THE TARGET ENZYME ATP YNTHASE 

15. Martin G. Montgomery, Jessica Petri et.al. (2021)[15] Described the structure of the ATP 

synthase from mycobacterium smegmati provides targets for treating tuberculosis. 

16. Hui Guo, Gautier M. Courbon et al., (2021) [18] briefly outlined the structure of 

mycobacterium ATP synthase bound to the tuberculosis drug bedaquiline. 

17. McNeil, M. B., Ryburn et al., (2020) [16] have detailed the transcriptional inhibition of the 

F1F0-type ATP synthase has bactericidal consequences on the viability of mycobacterium 

tuberculosis. 

18. Adam Hotra, Priya Ragunathan et al., (2020) [17] have described the discovery of a novel 

mycobacterium F-ATP synthase inhibitor and its potency in combination with 

diaryquinolines. 

19. Sunil kumar, rukmankesh mehra et al., (2017) [14] highlighted the screening of anti-

tubercular compounds library identifies novel ATP synthase inhibitors of mycobacterium 

tuberculosis. 

20. Aparna bahuguna, Diwan s.rawat (2019) [11] has assessed the development of new drugs, 

repurposed drugs and their potential drug targets. 

LITERATURES RELATED TO THE BASIC SCAFFOLD 

 

21. Dogan, D.Sengul(2020) [29]
 

synthesized various thiourea based derivatives against the InhA 

enzyme and structural characterization were performed. The Minimum Inhibitory 

Concentration (MIC) and percentage of Enzyme Inhibition was determined. Molecular 

docking and in-silico molecular property calculation for the synthesized molecules were 

carried out. 

22. Jiang D et al., (2018) [46] synthesized the various istain derivatives against anti-tubercular 

activity. 

https://www.nature.com/articles/s41586-020-3004-3#auth-Hui-Guo
https://www.nature.com/articles/s41586-020-3004-3#auth-Gautier_M_-Courbon
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23. Clay, Charles Michael et al., (2011) [21] reported the various methods of synthesis of Isatin 

and their chemical reactivity. 

24. Arockia Rajetal., (2001) [22]
 

synthesized novel Schiff bases of Isatin by the condensation of 

isatin and various substituents. The spectral data of the Schiff bases were interpreted. 

LITERATURES REGARDING THE COMPUTER AIDED DRUG DESIGN 

 

25. Fernando, D.Prielo Martinez (2019) [36] outlined the importance of the Computational 

drug design methods in the Drug Discovery process. 

26. Hachem, El.Nehme et al., (2017) [37] have visualized Docking as an essential 

computation tool for the Structure based drug design. 

27. Tien, Sheng et al., (2015) [38] established the importance of drug likeness of a molecule 

and their prediction by various in-silico filters. 

LITERATURES EXPLAINING THE MICROPLATE ALAMAR BLUE ASSAY (MABA) & 

ACUTE TOXICITY STUDIES 

28. WHO (2018)
 [30]

 published technical manual in which various methods for testing the drug 

susceptibility in solid and liquid media are clearly explained. 

29. Cho, Sanghyun (2015) [31] briefly explained the procedure involved in determining the Drug 

susceptibility by MABA. 

30. Jonsson, martina et al., (2013) [32]
 

have determined the acute toxicity of the Mycotoxin by 

following the OECD Guidelines 423 [Acute Oral Toxic Method]



Aim and Objectives 

 

DEPARTMENT OF PHARMACEUTICAL CHEMISTRY, COP, MMC. Page 17 
 

AIM & OBJECTIVES 

AIM: 

 

              The current study aims to develop novel anti-tubercular agents                                          

active against the Mycobacterium tuberculosis. 

 

OBJECTIVE: 

 

1. Sketching of isatin novel molecules using chemsketch. 

2. Application of, 

❖ PASS to determine overall pharmacological activity. 

❖ In-silico Drug likeness prediction. 

❖ In-silico Toxicity Assessment. 

❖ Design of ATP synthase inhibitors by docking studies using Autodock (1.5.6 version) 

software. 

❖ Laboratory synthesis of those compounds with top Docking Scores. 

❖ Characterization of the synthesized compounds by 

✓ Infrared Spectroscopy. 

✓ H1 NMR Spectroscopy. 

✓ Melting point. 

✓ LC-MS 

3. Determination of In-vitro anti -tubercular activity of the synthesized compounds by 

Microplate Alamar Blue Assay (MABA). 

4. Acute Toxicity on rats.
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PLAN OF THE WORK 

ATP synthase selected 
as an enzyme target

Designing of novel 
Isatin-urea schiff base 

derivatives

Toxicity Prediction 
by OSIRIS®

Property Explorer

In-silico assesment of 
druglikeness by 
Molinspiration® 

Characterization of 
the synthesized 

compounds by TLC, 
Melting point, IR, 
NMR &LC-MS.

In-vitro anti-
tubercular activity 
determination by 

MABA.

determination of Acute 
oral toxicity.

Docking aganist the 
target using 

AutoDock® tools

Laboratory synthesis

Patenting the Highly effective 
novel Anti-tubercular 

molecules.
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MATERIALS AND METHODS 

Drug discovery is a process through which new drug molecules are designed and 

developed using a combination of Computational, Experimental, Translational and 

Clinical models. In spite of the advances in Biotechnology and understanding in the 

biology of systems & diseases, introducing a new drug to the market is still an expensive 

and time-consuming process due to the proportion of failures in the clinical trials. 

Computer Aided Drug Discovery (CADD) helps us to save time and money. 

COMPUTER AIDED DRUG DESIGN (CADD): [34] 

In Computer Aided Drug Design (CADD), many computational approaches are 

utilized to discover, develop and analyze biologically active molecules. Virtual 

screening is one of the computational techniques used to identify the structures likely to 

bind the target protein or enzyme by searching libraries of small molecules. 

 

A. LIGAND BASED DRUG DESIGN: [63] 

Ligand based drug design is commonly employed when there is no information about the 

3D structure of the target receptor or enzyme, is available. It depends on the knowledge of 

the molecules or ligand that binds to the target protein. 

B. STRUCTURE BASED DRUG DESIGN: [63] 

When the structural information about the biological drug target is available, this approach 

is exploited for the development of the molecule inhibiting it. Structure Based Virtual 

Screening involves the identification of the potential ligand binding site on the drug target. 

SBDD involves, 

• Docking (Process of bringing & binding the two molecular structures 

together) of ligands into the target protein – the conformational space of the 

ligands which bind to the target molecules is explored. 

LIGAND BASED 
DRUG DESIGN 

[LBDD] 

DRUG DESIGN 

STRUCTURE 
BASED DRUG 
DESIGN [SBDD] 
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• Scoring i.e., ranking the docked set in accordance to the binding affinity of 

the ligand to the protein. 

AUTODOCK®TOOLS (ADT): [53] 

An AUTODOCK tools is used to predict the binding of small molecular ligands to the 3D 

structure of the known target. AutoDock® is molecular modeling simulation software 

developed by Scripps research. It involves docking the ligand to a set of grids which 

describes the target protein. Several rotatable bonds in the ligands are altered to get various 

conformations and the binding affinity of the conformers with the target is predicted. It is an 

automated random search docking technique which predicts the interaction between the 

Enzyme-inhibitor complexes, Peptide-antibody complexes and also Protein-protein complexes. 

It was shown to be useful in Blind Docking where the binding site location is not known. 

AutoDock 4.2 version is faster, more accurate, reliable and showed some 

additional advantages over the older ones. 

➢ Flexibility of the side chains in the macromolecule is allowed. 

➢ New free energy scoring function – AMBER force field is utilized, 

which is based on the linear regression analysis. 

➢ Larger set of Protein-ligand complexes with known inhibition constants is 

available. 

The current version of AutoDock® uses the Lamarckian Genetic Algorithm and 

empirical free energy scoring function to provide reproducible docking results for 

ligands.  Docking of ligands with the target protein involves the following steps, 

➢ Preparation of the target protein 

➢ Preparation of the ligands 

➢ Generation of 3D grids around the receptor &ligand 

➢ Docking (screening the binding energy) the ligand 

 

STEPS INVOLVED IN DOCKING: 

A. PROTEINPREPARATION: 

✓ File > Read molecule > Select Protein file in .pdbformat 

✓ Edit > Charges > Compute Gasteiger (for arbitrary molecules) 

✓ Edit > Hydrogens > Add > Polaronly 
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✓ Edit > Hydrogens > Merge Non-polar 

✓ Edit > Misc > Repair Missing Atoms 

✓ File > Save > Write PDB > Sort Nodes(Check) 

B. LIGAND PREPARATION: 

✓ Ligand > Input > Open > Select Ligand file in pdbformat 

✓ Edit > Charges > Add Kollman charges 

✓ Ligand > Torsion > Choose torsion [Rotatable bonds are shown in green, 

and non-rotatable bonds are shown in red. Bonds that are potentially 

rotatable but treated as rigid, such as amide bonds and bonds that are made 

rigid by the user are shown in magenta]. 

✓ Ligand > Torsion > Set number of torsions 

✓ Ligand > Output > Save as .pdbqt 

C. GRID GENERATION: 

✓ Grid > Macromolecule > choose Protein > Select molecule > Save as.pdbqt 

✓ Grid > Set map types > choose Ligand > Select ligand 

✓ Grid > Grid Box > Set the Grid Box dimensions (i.e., XYZ co-ordinates 100 

x 100 x 100) > File > Close Saving current 

✓ Grid > Output > Save as grid.gpf (Grid Parameter file) 

D. PREPARATION OF DOCKINGPARAMETERS: 

✓ Docking > Macromolecule > Set Rigid Filename > Select protein.pdbqt > 

Open 

✓ Docking > Ligand > Select Ligand >Accept 

✓ Docking > Search Parameters > Genetic Algorithm 

✓ Docking > Output > Lamarckian GA > Save as dock.dpf (Dock Parameter 

File) 

After completing the above steps, cmd (command prompt) was opened and moved to the 

destination work folder by cd commands. Then the following commands were given, 
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❖ autogrid4.exe –p grid.gpf –l grid.glg (wait for the response) 

❖ autodock4.exe –p dock.dpf –ldock.dlg. 

E. VISUALIZATION OFDOCKING: 

• Analyze > Docking > Select dock.dlg 

• Analyze > Macromolecule > Select Protein 

• Analyze > Conformations > Play ranked by energy 

• Set Play options > Build H-Bonds > Show info > Build Current > 

Write complex > Save asresult.pdb. 

• Analysis > Docking > Show interaction (Specialized visualization 

which highlights the interactions between the docked conformation 

of the ligand with the receptor). 

The Binding energy and the inhibitor constant values were noted from the results. Then 

the result.pdb file was viewed in the Molegro Molecular viewer. Electrostatic and Steric 

interactions between the various amino acids in the target protein and ligand were seen. 

IN SILICO ASSESMENT OF DRUGLIKENESS: [38] 

The undesirable ADMET (Absorption, Distribution, Metabolism, Excretion & 

Toxicity) profiles are the main cause behind the failure of turning a candidate molecule into 

a drug. To avoid the risk of attrition in the later stages of drug discovery, the concept of 

drug likeness was proposed by the Computational medicinal chemists in order to filter out 

the molecules with undesirable physicochemical properties. 

The designed and docked molecules are screened in silico using 

MOLINSPIRATION® Chem informatics software to evaluate drug likeness.  This online 

tool is quick and easy to use. This software used for calculation of important molecular 

properties log P, polar surface area, number of hydrogen bond donors and acceptors and 

others, as well as prediction of bioavailability score for the most important drug targets 

(GPCR ligands, Kinase inhibitors, ion channel modulators, nuclear receptors). 

Molecular properties of the designed ligands were predicted by drawing the structures in the 

online Molinspiration®tool: https://www.molinspiration.com/cgi-bin/properties[54] 

 

 

 

http://www.molinspiration.com/cgi-bin/properties
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IN-SILICO TOXICITY PREDICTION–OSIRIS® PROPERTY EXPLORER: [55] 

In silico toxicity prediction is done using OSIRIS® Property Explorer. It is free 

software available for access in the Organic Chemistry Portal. Using this online 

prediction tool, mutagenicity, tumerigenicity, skin irritation and reproductive effects can 

be determined. The tool detects the toxicity risk alerts and indicated by red colour. The 

green colour confirms the drug like behavior of the compounds without any toxicity 

alerts. 

The in-silico toxicity of the designed compounds was predicted by drawing the 

structures in online tool – 

http://www.cheminfo.org/Chemistry/Cheminformatics/Property_explorer/index.ht

ml# 

SYNTHETIC METHODOLOGY: 

STEP: 1 

The ethanolic solution of (25ml) isatin (0.001M) was mixed with ethanolic solution of (25ml) urea 

(0.001) and 3-4 drops of glacial acetic acid were added. Then the mixture was stirred for two hours 

by using magnetic stirrer at 60ᵒC. The solution was filtered and washed with ethanol and 

recrystallized from ethanol.

 

STEP: 2 

Equimolar (0.002M)  quantity of intermediate step-1 was treated with various substituted aromatic 

aldehydes in 20ml of ethanol in the presence of glacial acetic acid. The contents were refluxed at 

80ᵒC for 6 hours. The progress of reaction was monitored by TLC. After completion of the reaction 

the contents of the flask were poured over the crushed ice. The solid obtained was filtered, washed 

with cold water, dried and finally recrystallized from ethanol. 

 

http://www.cheminfo.org/Chemistry/Cheminformatics/Property_explorer/index.html
http://www.cheminfo.org/Chemistry/Cheminformatics/Property_explorer/index.html
http://www.cheminfo.org/Chemistry/Cheminformatics/Property_explorer/index.html
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STEP-2 SYNTHETIC SCHEME 

 

REACTANT PROFILE 

❖ ISATIN 

 

Molecular Formula          :  C8H5NO2 

Molecular Weight   :  147.13g/mol 

Appearance   :  Orange red powder 

Melting point   :  200o C 

Density  :  1.4 g/cm3 

❖ UREA 

 

 

Molecular Formula  : CH4N2O 

Molecular Weight  : 60 g/mol 

Appearance  : White crystalline solid 

Melting point  : 133o C 

Density  : 1.335 g/cm3 
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❖ SALICYALDEHYDE 

 

Molecular Formula  : C7H6O2 

Molecular Weight  : 122 g/mol 

Appearance  : pale yellow liquid 

Boiling point  : 194o C 

Density      : 1.17 g/cm3 

❖ ANISALDEHYDE 

 

                      Molecular Formula  : C8H8O2 

Molecular Weight  : 136 g/mol 

Appearance  : slightly yellow liquid 

Boiling point  : 248o C 

Density  : 1.12 g/cm3 

❖ CINNAMALDEHYDE 

 

Molecular Formula  : C9H8O 

Molecular Weight  : 111.12 g/mol 

Appearance  : yellow oily liquid 

Boiling point  : 248o C 

Density  : 1.05 g/cm3 
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❖ 3-NITRO BENZALDEHYDE 

 

                      Molecular Formula  : C7H5NO3 

Molecular Weight  : 151 g/mol 

Appearance  : yellowish to brownish crystalline powder 

Melting point  : 58.5o C 

Density  : 1.338 g/cm3 

 

❖ 4-CHLORO BENZALDEHYDE 

 

Molecular Formula  : C7H5OCl 

Molecular Weight  : 140 g/mol 

Appearance  : white crystalline solid 

Melting point  : 48o C 

Density  : 1.196 g/cm3 

 

CHARACTERIZATION STUDIES: 

❖ Determination of Melting point: Purity of the synthesized compounds were 

evaluated by determining Melting point using the Digital Melting point apparatus. 

❖ Thin Layer Chromatography (TLC): Pre-coated silica plates were used for TLC. 

Various proportion of different solvents were tried as Mobile phase and by trial and 

error method Methanol:Chloroform in the ratio of 9:1 was chosen as the Mobile 

phase. TLC was performed to confirm the completion of the synthetic reaction by 

comparing the Rf value of the reactants and products. 
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❖ Physical Evaluation: The following physical properties of the synthesized 

compounds were evaluated, 

✓ Color 

✓ Nature 

✓ Solubility 

✓ Melting point 

❖ Spectroscopic Evaluation: The synthesized compounds were further 

characterized by the following Spectroscopic methods, 

✓ Infrared Spectroscopy (IR) 

✓ Nuclear Magnetic Spectroscopy (1H – NMR) 

✓ Liquid Chromatography – Mass Spectrometry(LC-MS) 

INFRARED SPECTROSCOPY: [56] 

FTIR is a technique which is used to obtain infrared spectrum of absorption, emission and 

photoconductivity of solid, liquid and gas samples.  Fourier transform infrared spectroscopy (FTIR) 

uses the mathematical process (Fourier transform) to translate the raw data (interferogram) into the 

actual spectrum. FTIR identifies the presence of organic and inorganic compounds in the sample, 

depending on the infrared absorption frequency range 600-4000cm-1. It relies on the fact that 

chemical molecules absorb certain frequencies that are characteristic to their structure. For a vibration 

to absorb the infrared energy there must be a change in the dipole moment and that influences the 

intensity of the infrared absorptions. The infrared portion of the electromagnetic spectrum is divided 

into, 

i. Near IR – 14000-4000 cm-1 (1.4-0.8m) 

ii. Mid IR -4000-400 cm-1 (30-1.4m) 

iii. Far IR – 400-10 cm-1 (1000-30m) 

The number of observed absorptions may be increased by combination tones and 

overtones of the functional vibrations and decreased by molecular symmetry & spectrometer 

limitations. Unique patterns are found in the region of 1450-600cm-1 and it is referred as 

Fingerprint region. Absorption bands in the 4000-1400cm-1 region are mainly due to the 

stretching vibrations of the diatomic units and it is referred as Group frequency or Functional 

group region. 
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Table 05: Group Frequencies in Infrared Region 

ABSORPTION 

(cm-1) 

APPEARANCE 

OF PEAK 

FUNCTIONAL 

GROUP 

COMPOUND 

CLASS 

3500 Medium N-H Stretching Primary amine 

3350-3310 Medium N-H Stretching Secondary amine 

2000-1650 Weak C-H Stretching Aromatic compounds 

1685-1666 Strong C=O Stretching Conjugated ketones 

1648-1638 Weak C=C Stretching Alkene 

1650-1580 Medium N-H Bending Amine 

1465 Medium C-H Bending Alkane 

900-700 Strong C-H Stretching Benzene derivatives 

850-550 Strong C-Cl Stretching Chloro compounds 

The IR Spectra of the synthesized compounds were obtained from the ABB MB3000 FT-

IR Spectrometer. 

NUCLEAR MAGNETIC RESONANCE SPECTROSCOPY (NMR):[58] 

One of the important techniques used to obtain the physical, chemical, 

electronic and structural information about the molecule is NMR Spectroscopy. This 

research technique exploits the magnetic properties of certain atomic nuclei including 1H 

(Proton), 13C (Carbon), 15N (Nitrogen) and 19F (Fluorine). The qualitative 

information about a molecule can be obtained based on the chemical shift produced in 

the resonance frequencies of nuclear spins in the sample. NMR Spectroscopy is based on 

the principles such as, 

• All atomic nuclei have their own spin and are electrically charged 

• In the presence of an external magnetic field, transfer of energy from the base 

level to the higher energy level occurs at a wavelength that coincides with the 

radio frequency. 

• When the spin returns to its base ground state emission of energy at the same 

frequency is possible. 
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• NMR Spectrum for the sample molecule is processed by measuring the signal 

which matches the transfer frequency. 

The amount of energy and the frequency of Electromagnetic radiation required for 

resonance to occur depends on the strength of the applied external magnetic field and the 

type of nucleus involved in the study. 

CHEMICAL SHIFT:  

The NMR Spectrum is displayed as a plot of the applied radio frequency versus the 

absorption. The position in the plot at which the nuclei absorbs the electromagnetic 

radiation is called the Chemical shift. 

➢ Left side of the plot – Downfield or De shielded side 

➢ Right side of the plot – Upfield or Shielded side 

TMS (Tetramethylsilane) is commonly used as a standard reference and 

assigned a chemical shift of zero. The δ-scale is expressed as parts per million 

(ppm). 

In the Proton NMR spectrum, the peaks are splitten into groups due to the 

coupling between the adjacent protons in the sample molecule. The interaction between 

the pair of protons is measured by Coupling constant (J). 

Thus, in a NMR spectrum 

 

➢ The location of the peak (chemical shift) provides information about the local 

chemical environment adjacent to the proton. 

➢ The integration ratio or intensity of the peak depends on the number of 

equivalent type of protons in the molecule. 

➢ The coupling pattern or multiplicity is based on the number of protons on the 

adjacent carbon atom. 

This information gives us the idea about the basic skeletal information of the molecule.    
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Table 06: Chemical Shift values in NMR 

Types of protons δ (ppm) 

R-CH3 0.9 

R-CH2-R 1.3 

Ar-CH3 2-3 

R2N-CH3 2.3 

RO-CH3 3.8 

R-CH2-F 4.5 

Ar-H 7.3 

 

HYPHENATED TECHNIQUES: [33] 

Coupling of different analytical techniques i.e., commonly a chromatographic 

technique is combined with a spectroscopic technique and are known as hyphenated 

techniques. Components in the sample mixture are separated by the chromatographic 

technique and then each component enters into the spectroscopic analysis via a suitable 

inter phase. The term hyphenated technique ranges for the combination of techniques 

including, 

1) Separation – separation 

2) Separation – identification 

3) Identification – identification. 
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DOUBLE HYPHENATED 

TECHNIQUES 

TRIPLE HYPHENATED 

TECHNIQUES 

LC-MS LC-API-MS 

LC-NMR ESI-MS-MS 

LC-IR LC-NMR-MS 

GC-MS APCI-MS-MS 

GC-FTIR LC-PDA-MS 

 

LC-MS [Liquid Chromatography – Mass Spectrometry] 

LC-MS is an analytical technique which combines the physical separation of 

liquid chromatography (HPLC) with the Mass Spectrometry by an interface. To obtain 

only few fragment ions with the molecular ion, soft ionization techniques are utilized in 

the LC-MS. For confirming the identity of the compound single LC-MS run is not 

sufficient. Scanning speed of the MS is influenced by the Chromatographic resolution, 

therefore to achieve accurate integration, it is suggested to have 10 scans across the 

chromatographic peak. 

The hyphenated technique LC-MS includes, 

➢ LC – Liquid chromatography separates the sample mixture into individual 

components 

➢ Interface – transfers the separated component from LC Column to MS ion source 

➢ MS – Mass spectrometry identifies the structure of the individual components 

Liquid chromatography involves the separation of components in the liquid mixture 

by distributing them between the two immiscible phases (Stationary & Mobile phase). 

Typically in HPLC, 20µl of sample is injected into the mobile phase by a high pressure 

pump. The sample mixed with the mobile phase permeates through the stationary bed 

and gets separated based on their differential affinities towards the stationary & mobile 

phases and gets eluted from the column at different times (Rt). Reverse Phase Partition  
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Chromatography (Non-polar stationary phase and polar mobile phase) is widely 

used. 

The interface is designed to offer adequate nebulization and vaporization of the 

solvent, ionization of the sample, removal of the excess solvent vapour and the extraction 

of the ions. The transition of components from the High-pressure environment of HPLC 

to High vacuum condition in the Mass analyzer is facilitated by the interface. The 

commonly used interfaces are, 

• Electro spray Ionization Interface (ESI), 

• Atmospheric Pressure Chemical ionization Interface (APCI). 

MS is an analytical technique that measures the Mass to charge ratio (m/z) of the 

charged ions. The ions produced from the analyte are manipulated by the electric and 

magnetic fields to determine their m/z ratio. The basic components include, 

❖ Ion source: Components in the sample mixture is ionized by electron/photon 

beams which fragments the sample molecules into gas phase ions and sent to 

analyzers. 

❖ Mass analyzer: Ions are sorted according to their masses. 

❖ Detector: Abundance of each ion is measured by the detection through 

amplification. 

The synthesized compounds were characterized by LC-MS instrument – Agilent 

technologies 6230B TOF (Time of Flight). 

 

 

 

 

 

 

 

 



Materials and methods 

 

DEPARTMENT OF PHARMACEUTICAL CHEMISTRY, COP, MMC. Page 33 
 

BIOLOGICAL EVALUATION [60] 

The designed and synthesized molecules need to be screened for their activity to 

inhibit the growth of the Mycobacterium tuberculosis. 

MICROPLATE ALAMAR BLUE ASSAY: [35] 

The Micro Plate Alamar Blue Assay (MABA) method was used to evaluate anti-

tubercular activity of the synthesized compounds Mycobacterium tuberculosis 

H37Rv strain.  Alamar blue dye is used as an indicator for the determination of 

viable cells. The oxidized form, Resazurin is non- toxic, non-fluorescent and blue in 

colour which becomes pink and fluorescent upon reduction of resazurin by viable 

cells. 

PROCEDURE: 

1. The anti-mycobacterial activity of compounds were assessed against M. 

tuberculosis using Micro Plate Alamar Blue assay (MABA). 

2. This methodology is non-toxic, uses a thermally stable reagent and shows good   

correlation with BACTEC radiometric method. 

3. 200µl of sterile de-ionized water was added to all outer perimeter wells of sterile 

96 wells plate to minimize evaporation of medium in the test wells during 

incubation. 

4. The 96 wells plate received 100 µl of the Middle brook 7H9 broth and serial 

dilutions of compounds were made directly on plate. 

5. The final drug concentrations tested were 100 to 0.8µg/ml. 

6. Plates were covered and sealed with Para film and incubated at 37ºC for five days. 

7. After this time, 25µl of freshly prepared 1:1 mixture of Alamar Blue reagent and 

10% tween 80 was added to the plate and incubated for 24 hrs. 

8. A blue colour in the well was interpreted as no bacterial growth, and pink colour was 

scored as growth. 

9. The MIC was defined as lowest drug concentration, which prevented the color change 

from blue to pink. 
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ACUTE ORAL TOXICITY STUDY: [36] [37] 

Acute oral toxicity study was designed as per the OECD guidelines (423). OECD [Organization for 

Economic Co-operation and Development] guidelines for the testing of chemicals are an 

internationally accepted set of  specifications for testing the chemicals. It includes five sections, 

Table 07: Guidelines under the sections of OECD 

S. No SECTIONS GUIDELINES 

1. Physical & Chemical Properties 101 – 123 

2. Effects on Biotic Systems 201 – 241 

3. Environmental Fate and Behavior 301 – 317 

4. Health Effects 401 – 493 

5. Other test guidelines 501 – 509 

 

PRINCIPLES AND PURPOSE: 

The main purpose of acute toxicity is to evaluate the degree of toxicity in a quantitative   and 

qualitative manner. 

SELECTION OF DOSE LEVELS AND ADMINISTRATION OF DOSE: 

Being synthetic molecules, the mortality was unlikely at the highest starting dose level 

(2000mg/kg/b.w). Hence a limit test one dose levels of 2000mg/kg/b.w was conducted in all 

animals as per the OECD guidelines (423). 

PROCEDURE: 

✓ The study was performed as per the OECD guidelines 423 (acute toxic class method. 

✓ Animals were fasted prior to dosing (3-4 hrs.) 

✓ Animals were weighed and test substance will be administered orally. 

✓ After dosing animals were observed for 30 mins and special attention was given   during first 

4 hrs. 

✓ Finally, animals were obsereved for behavioural signs of toxicity for 14 days. 
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RESULTS AND DISCUSSION 

1. RESULTS OF DRUG DESIGN: 

❖ Five hundred molecules were designed using ACD/Chem Sketch® 

(Freeware) software by performing structural modifications in the basic 

hetero nuclear scaffold Isatin. 

❖ Energy minimization of the designed molecules was performed in Chem3D 

Ultra® software. 

❖ The designed molecules were coded for identification. 

 

2. RESULTS OF IN SILICO DRUG LIKENESS AND TOXICITY 

PREDICTION: 

Lipinski’s rule of five explains the ability of the chemical compound with 

certain physicochemical property to make it an orally active drug. This rule 

describes the important pharmacokinetics properties like absorption, distribution, 

metabolism and excretion (ADME). 

➢ For a molecule to be orally active it must have drug likeness properties 

according to the Lipinski’s rule of five and it must be non-toxic. 

➢ The molecules were evaluated for their drug likeness behavior using the 

online tool – Molinspiration® Cheminformatics. 

➢ The toxicity of the molecules was assessed using OSIRIS® Property 

Explorer. 
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Table 08: In silico Drug-likeness and Toxicity prediction 

COMPOUND 

CODE 

IN SILICO DRUG LIKENESS 

PREDICTION 

IN SILICO TOXICITY 

ASSESSMENT 

 

 

 

 

        JP1 

 
 

 

 

 

JP2 

  

 

 

 

 

JP3 
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JP4 

  

 

 

 

JP5 

 

 

 

➢ The above molecules showed no violations of Lipinski’s rule and no 

toxicity risks (no red colour alert) were shown in OSIRIS® Property 

Explorer. 

➢ The non-toxic, drug like molecules were subjected to Molecular Docking 

studies. 

 

3. RESULTS OF MOLECULAR DOCKING: 

❖ The non-toxic molecules were docked against the target enzyme ATP 

SYNTHASE (PDB ID – 7JG5) of Mycobacterium tuberculosis to determine 

their effectiveness as an anti-tubercular agent. 

❖ Five top scored molecules were further synthesized, characterized and 

evaluated. 
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Table 09: Code, Molecular Structure, Binding energy and Inhibition 

constant value of the top scored compounds. 

COMPOUN

D CODE 

 

MOLECULAR STRUCTURE 

BINDIN

G 

ENERG

Y 

(kcal/mol) 

INHIBITIO

N 

CONSTAN

T (nM) 

 

 

 

 

JP1 

 

 

 

 

 

 

-7.53 

 

 

 

 

4.39 

 

 

 

 

JP2 

 

 

 

 

 

 

-8.86 

 

 

 

 

321.13 
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JP3 

 

 

 

 

 

-7.59 

 

 

 

 

2.72 

 

 

 

 

JP4 

 

 

 

 

 

 

-9.4 

 

 

 

 

128.18 

 

 

 

 

JP5 

 

 

 

 

 

 

-9.29 

 

 

 

 

155.53 

 

➢ The docking score of the molecules were found to be in the range of -7 to -9.4 

kcal/mol. 

➢ The inhibition constant value of the molecules was in the range of 2 to 321 nm. 
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Table 10: Interactions of molecules with the amino acids and docking view 

 

COMPOUN

D CODE 

INTERACTION 

WITH 

AMINOACIDS 

DOCKING VIEW 

 

 

 

 

 

JP1 

 

 

 

 

 

 

 

 

 

 

JP2 

 

 

 

 

 

 

 

 

 

JP3 
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JP4 

 

 

 

 

 

 

 

 

 

 

 

 

 

JP5 

 

 

 

 

 

 

 

 

 

➢ The Electrostatic, Hydrogen bond and Steric interactions between the 

ligands and the amino acids in the target enzyme were observed using the 

Molegro Molecular® viewer. 
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4. PRODUCT PROFILE: 

➢ Molecules which were found to be non-toxic in the in-silico toxicity 

assessment tool were synthesized by suitable laboratory process and 

recrystallized using ethanol. 

➢ Completion of the synthetic reaction was determined by comparing the Rf 

values of the reactants and products. Rf value of the products was found 

to be different from the Rf value of the reactants. 

➢ Melting point of the products was determined by Digital Melting Point 

Apparatus. Sharp melting point denotes the purity of the synthesized 

compound. 

 

 

Table 11: Data of the synthesized compounds JP1 – JP5 

 

CODE 

 

COLOUR 

 

SOLUBILITY 
MELTING  

POINT 

Rf 

VALUE 

PERCENTAGE 

YIELD 

JP1 
Reddish 

brown 

Methanol, 

Ethanol, DMSO 
161o C 0.70 84% 

JP2 Reddish  

brown 

Methanol, 

Ethanol, DMSO 
172 o C 0.64 82% 

JP3 Reddish  

brown 

Methanol, 

Ethanol, DMSO 
163 o C 0.78 78% 

JP4 Reddish  

orange 

Methanol, 

Ethanol, DMSO 
114o C 0.69 88% 

JP5 Reddish  

brown 

Methanol, 

Ethanol, DMSO 
170 o C 0.57 85% 
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COMPOUND JP1 

 

IUPAC NAME: 1-[(E)-(2-hydroxy phenyl) methylidene]-3-[(3Z)-2-oxo-1, 

2-dihydro-3H-indol-3-ylidene] urea 

 

 

  

Molecular Formula   : C16H11N3O3 

Formula Weight   : 293.27684 

Composition    :  C (65.53%) H (3.78%) N (14.33%) O (16.37%) 

Molar Refractivity   :  80.35 ± 0.5 cm3 

Molar Volume   :  210.6 ± 7.0 cm3 

Parachor    :  584.0 ± 8.0 cm3 

Index of Refraction   :  1.688 ± 0.05 

Surface Tension   :  59.1 ± 7.0 dyne/cm 

Density    : 1.39 ± 0.1 g/cm3 

Dielectric Constant   : Not available 

Polarizability    : 31.85 ± 0.5 10-24cm3 
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INFRARED SPECTRUM OF JP1: 

 

Figure 06: IR Spectrum of Compound JP1 

 

Table 12: IR interpretation of compound JP1 

S.NO WAVE NUMBER (cm-1) FUNCTIONAL GROUP 

01. 1620.09 C=N Stretching 

02. 3448.47 OH Stretching 

03. 1728.09 C=O Stretching 

04. 3193.88 N-H Stretching 
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PROTON NMR SPECTRUM OF JP1: 

Figure 07: 1H NMR Spectrum of Compound JP1 

 

 

 

Table 13: Interpretation of 1H NMR Spectrum of Compound JP1 

 

S.NO 

δ VALUE 

(PPM) 

NATURE OF 

PROTONS 

NATURE OF 

THE PEAK 

NUMBER 

OF  

PROTONS 

01. 11.135 CH=N Singlet 1 

02. 3.45 Ar-OH Singlet 1 

03. 7.2-7.4 Ar-H Multiplet 4 

 

  

 



Result and Discussion 

 

DEPARTMENT OF PHARMACEUTICAL CHEMISTRY, COP, MMC. Page 46 
 

LC-MS SPECTRUM OF JP1: 

 

Figure No 08: Chromatogram of compound JP1 

 

Molecular weight of JP1:293.28 g/mol 

 

Figure No 09: Mass Spectrum of Compound JP1 
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COMPOUND JP2 

 

IUPAC NAME: 1-[(E)-(4-methoxy phenyl) methylidene]-3-[(3Z)-2-oxo-

1, 2-dihydro-3H-indol-3-ylidene] urea 

 

 

  

Molecular Formula     C17H13N3O3 

Formula Weight      307.30342 

Composition      C (66.44%) H (4.26%) N (13.67%) 

O (15.62%) 

Molar Refractivity     85.31 ± 0.5 cm3 

Molar Volume      235.0 ± 7.0 cm3 

Parachor       628.6 ± 8.0 cm3 

Index of Refraction     1.646 ± 0.05 

Surface Tension      51.1 ± 7.0 dyne/cm 

Density       1.30 ± 0.1 g/cm3 

Dielectric Constant     Not available 

Polarizability      33.82 ± 0.5 10-24cm3 
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INFRARED SPECTRUM OF JP2: 

 

Figure 10: IR spectrum of Compound JP2 

 

 

 

 

Table 14: IR Interpretation of Compound JP2 

S.NO WAVE NUMBER (cm-1) FUNCTIONAL GROUP 

01. 1612.37 C=N Stretching 

02. 1326.93 C-O-C Stretching 

03. 1728.09 C=O Stretching 

04. 3193.88 N-H Stretching 

 

  

 



Result and Discussion 

 

DEPARTMENT OF PHARMACEUTICAL CHEMISTRY, COP, MMC. Page 49 
 

PROTON NMR SPECTRUM OF JP2: 

Figure 11: 1H NMR Spectrum of Compound JP2 

 

 

 

Table 15: Interpretation of 1H NMR Spectrum of Compound JP2 

 

  
 

S.NO 

δ VALUE 

(PPM) 

NATURE 

OF  

PROTONS 

NATURE OF 

THE PEAK 

NUMBER OF 

PROTONS 

01. 11.03 CH=N          Singlet 1 

02. 7.2-7.6 Ar-H         Multiplet 4 

03. 3.3 -OCH3 Singlet 1 
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LC-MS SPECTRUM OF JP2: 

 

Figure No12: Chromatogram of compound JP2 

 

Molecular Weight of JP2: 307.31g/mol 

 

Figure No13: Mass Spectrum of Compound JP2 
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COMPOUND JP3 

 

 

IUPAC NAME: 1-[(3Z)-2-oxo-1, 2-dihydro-3H-indol-3-ylidene]-3-[(1E, 2E)-

3-phenyl prop-2-en-1-ylidene] urea 

 

 

  

Molecular Formula     C18H13N3O2 

Formula Weight      303.31472 

Composition      C (71.28%) H (4.32%) N (13.88%) O (10.55%) 

Molar Refractivity    88.72 ± 0.5 cm3 

Molar Volume      245.5 ± 7.0 cm3 

Parachor      655.5 ± 8.0 cm3 

Index of Refraction     1.642 ± 0.05 

Surface Tension      50.68± 7.0 dyne/cm 

Density      1.23 ± 0.1 g/cm3 

Dielectric Constant     Not available 

Polarizability      35.17 ± 0.5 10-24cm3 
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INFRARED SPECTRUM OF JP3: 

 

Figure 14: IR Spectrum of Compound JP3 

 

 

 

 

Table 16: IR Interpretation of Compound JP3 

S.NO WAVE NUMBER (cm-1) FUNCTIONAL GROUP 

01. 1620.09 C=N Stretching 

02. 1458.08 C=C Stretching 

03. 1728.09 C=O Stretching 

04. 3186.17 N-H Stretching 
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PROTON NMR SPECTRUM OF JP3: 

 

Figure 15: 1H NMR Spectrum of Compound JP3 

 

 

 

 

Table 17: Interpretation of 1H NMR Spectrum of Compound JP3 

S.NO 
δ VALUE 

(PPM) 

NATURE OF 

PROTON 

NATURE OF 

THE PEAK 

NUMBER OF 

PROTONS 

01. 11.040 N=CH Singlet 1 

02. 7.4-7.6 Ar-H Multiplet 4 

03. 6.8-7.2 CH=CH-CH Multiplet 3 
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LC-MS SPECTRUM OF JP3: 

 

Figure 16: Chromatogram of Compound JP3 

 

Molecular Weight of JP3: 303.32 g/mol 

 

Figure 17: Mass Spectrum of Compound JP3 
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COMPOUND JP4 

 

IUPAC NAME: 1-[(E)-(3-nitro phenyl) methylidene]-3-[(3Z)-2-oxo-1, 2-dihydro-3H-

indol-3-ylidene] urea 

 

  

Molecular Formula   :  C16H10N4O4 

Formula Weight    : 322.275 

Composition    : C (59.63%) H (3.13%) N (17.38%) O (19.86%) 

Molar Refractivity   : 85.16 ± 0.5 cm3 

Molar Volume    : 218.6 ± 7.0 cm3 

Parachor     : 623.8 ± 8.0 cm3 

Index of Refraction   : 1.706 ± 0.05 

Surface Tension    : 66.2 ± 7.0 dyne/cm 

Density     : 1.47 ± 0.1 g/cm3 

Dielectric Constant   : Not available 

Polarizability    : 33.76 ± 0.5 10-24cm3 
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INFRARED SPECTRUM OF JP4: 

 

Figure 18: IR Spectrum of Compound JP4 

 

 

 

 

Table 18: IR Interpretation of Compound JP4 

S.NO WAVE NUMBER (cm-1) FUNCTIONAL GROUP 

01. 1612 C=N Stretching 

02. 3062.73 Ar-CH 

03. 1728.09 C=O Stretching 

04. 1535 NO2 
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PROTON NMR SPECTRUM OF JP4: 

 

Figure 19: 1H NMR Spectrum of Compound JP4 

 

 

 

Table 19: Interpretation of 1H NMR Spectrum of Compound JP4 

 

S.NO 
δ VALUE 

(PPM) 

NATURE OF 

PROTON 

NATURE OF 

THE PEAK 

NUMBER OF 

PROTONS 

01. 11 CH=N Singlet 1 

02. 7.2-7.6 Ar-H Multiplet 4 

03. 10.151 -NH Singlet 1 
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LC-MS SPECTRUM OF JP4: 

 

Figure 20: Chromatogram of compound JP4 

 

Molecular Weight of JP4: 328.28 g/mol 

 

Figure 21: Mass Spectrum of Compound JP4 
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COMPOUND JP5 

 

IUPAC NAME: 1-[(E)-(4-chloro phenyl) methylidene]-3-[(3Z)-2-oxo-1, 2-dihydro-3H-

indol-3-ylidene] urea  

 

  

Molecular Formula   :  C16H10ClN3O2 

Formula Weight    :  311.7225 

Composition    :  C (61.65%) H (3.23%) Cl (11.37%) N (13.48%) 

O (10.27%) 

Molar Refractivity   :  84.10 ± 0.5 cm3 

Molar Volume    :  222.6 ± 7.0 cm3 

Parachor     :  607.1 ± 8.0 cm3 

Index of Refraction   :  1.679 ± 0.05 

Surface Tension    :  55.3 ± 7.0 dyne/cm 

Density     :  1.40 ± 0.1 g/cm3 

Dielectric Constant               :  Not available 

Polarizability                           :   33.34 ± 0.5 10-24cm3 
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INFRARED SPECTRUM OF JP5: 

 

Figure 22: IR Spectrum of Compound JP5 

 

 

 

Table 20: IR Interpretation of Compound JP5 

S.NO WAVE NUMBER (cm-1) FUNCTIONAL GROUP 

01. 1612.37 C=N Stretching 

02. 1728.09 C=O Stretching 

03. 3193.88 N-H Stretching 

04. 771.47 C-Cl Stretching 
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PROTON NMR SPECTRUM OF JP5: 

 

Figure 23: 1H NMR Spectrum of Compound JP5 

 

 

 

Table 21: Interpretation of 1H NMR Spectrum of Compound JP5 

 

S.NO 

δ VALUE 

(PPM) 

NATURE OF 

PROTON 

NATURE OF 

THE PEAK 

NUMBER OF 

PROTONS 

01. 11.038 CH=N Singlet 1 

02. 6.8-7.2 Ar-H Multiplet 4 

03. 9.009 -NH     Singlet 1 
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LC-MS SPECTRUM OF JP5: 

 

Figure 24: Chromatogram of Compound JP5 

 

Molecular Weight of JP5: 311.73 g/mol 

 

Figure 25: Mass Spectrum of Compound JP5 
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➢ All the five synthesized compounds had a different Rf value from the reactant 

molecules and showed a single spot in the thin layer chromatogram. 

➢ They exhibited a sharp melting point. 

➢ In the IR spectrum, absorptions corresponding to the relevant functional groups 

were seen. 

➢ From the NMR spectrum, numbers of protons present in the molecular structure 

were elucidated and the structure of the compound was confirmed. 

➢ In LC-MS analysis, all the compounds were determined as a single peak. The 

molecular mass of the compounds was obtained from Mass spectrometry. 

➢ The actual mass obtained from the M+1 peak of mass spectrum was similar to the 

calculated mass of the compounds. 

 

 

 

Table 22: Comparison of Calculated & Obtained Molecular mass of the Compounds 

JP1 – JP5. 

 

CODE 

CALCULATED 

MASS (g/mol) 

ACTUAL MASS 

(g/mol) 

JP1 293.28 295.55 

JP2 307.31 308.95 

JP3 303.32 304.35 

JP4 328.28 328 

JP5 311.73 311 
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5. RESULTS OF ANTI-TUBERCULAR ACTIVITY: 

The recrystallized pure compounds were evaluated for their Anti-tubercular 

activity by in vitro Microplate Alamar Blue Assay (MABA). 100 – 0.8 µg/ml dilutions of 

the compounds were made using Dimethyl sulfoxide (DMSO). 

Table 23: Data of MABA results of the compounds JP1 – JP5 (100–0.8 µg/ml) 

SAMPLE 

CODE 

100 

µg/ml 

50 

µg/ml 

25 

µg/ml 

12.5 

µg/ml 

6.25 

µg/ml 

3.12 

µg/ml 

1.6 

µg/ml 

0.8 

µg/ml 

JP1 S S R R R R R R 

JP2 S S R R R R R R 

JP3 S S R R R R R R 

JP4 S S R R R R R R 

JP5 S R R R R R R R 

  

S – SENSITIVE R – RESISTANT 

 

Table 24: Visualization of MABA results of the compounds JP1 – JP5 (100 –0.8µg/ml) 

SAMPLE 

CODE 

100 

µg/ml 

50 

µg/ml 

25 

µg/ml 

12.5 

µg/ml 

6.25 

µg/ml 

3.12 

µg/ml 

1.6 

µg/ml 

0.8 

µg/ml 

JP1 

 

JP2 

JP3 

JP4 

JP5 
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MINIMUM INHIBITORY CONCENTRATION (MIC VALUES) OF STANDARD 

ANTI-TUBERCULAR DRUGS: 

1. Isoniazid – 1.6 µg/ml 

2. Ethambutol – 1.6 µg/ml 

3. Pyrazinamide- 3.125µg/ml 

4. Rifampicin – 0.8 µg/ml 

5. Streptomycin- 0.8µg/ml 

 

Table 25: Visualization of MABA results of the Standard Anti-tubercular drugs 

STANDARD 

DRUG 

100 

 

µg/ 

ml 

50 

 

µg/ 

ml 

25 

 

µg/ 

ml 

12.5 

 

µg/ 

ml 

6.25 

 

µg/ 

ml 

3.12 

 

µg/ 

ml 

1.6 

 

µg/ 

ml 

0.8 

 

µg/ 

ml 

0.4 

 

µg/ 

ml 

0.2 

 

µg/ 

ml 

Isoniazid 

 

Ethambutol 

Pyrazinamide 

Rifampicin 

Streptomycin 

 

 All the five synthesized compounds show anti tubercular activity in the MIC values 

of  50µg/ml and 100 µg/ml. 
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6. RESULTS OF ACUTE ORAL TOXICITY STUDIES: 

The synthesized Compounds JP1-JP5 was selected for acute oral toxicity studies. 

The study was conducted based on the OECD Guidelines 423. A dose of 2000 

mg/kg was administered to the animals and the behavioral signs of toxicity were 

observed. Parameters which were evaluated during the     study and the observations 

were tabulated below, 

Table 26: Parameters evaluated during the Acute toxicity study 

S.NO PARAMETERS OBSERVATION 

1. Aggressiveness Absent 

2. Analgesia Absent 

3. Body temperature Normal 

4. Body weight No significant change 

5. Convulsions Absent 

6. Diarrhoea Absent 

7. Lacrimation Normal 

8. Lighting reflex Present 

9. Motor activity Normal 

10. Pre-terminal death Nil 

11. Respiration Normal 

12. Restlessness Absent 

13. Salivation Normal 

14. Sedation Absent 

15. Skin colour Normal 

16. Toxic signs Absent 

17. Tremors Absent 

 

❖ No significant toxic signs were observed and no mortality was reported up to 

14 days of study. 

❖ The five compounds were found to be non-toxic and safe for oral administration 

up to the dose of 2000mg/kg body weight.
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SUMMARY 

➢ TB is the most attractive areas of research, because it is the Second major cause of 

death due to an infectious disease in adults. 

➢ Twenty-two countries of the world have the highest TB burden, among top five ranking 

countries are India, China, Indonesia, South Africa and Nigeria. 

➢ Drug resistance TB plays a major challenge for the effective control of TB. 

➢ Therefore, the current work aimed to synthesize some novel anti-tubercular compounds. 

➢ Based on the literature review, ATP SYNTHASE of Mycobacterium tuberculosis was 

chosen as the target enzyme against which novel molecules were designed by 

performing structural modifications in the basic hetero nuclear scaffold Isatin. 

➢ The designed molecules were docked against the target using the MGL tools. 

➢ The top scored compounds were assessed for their in-silico drug likeness property and 

toxicity profile. 

➢ The non-toxic molecules were synthesized by an appropriate laboratory process and 

they were coded from JP1 to JP5. Completion of the reaction was determined by TLC. 

➢ The synthesized compounds were subjected to repeated recrystallization using ethanol 

and Purity of the compounds was ensured by sharp melting point. 

➢ Further the compounds were characterized by spectroscopic analysis such as IR, NMR 

& LC-MS. 

➢ Anti-tubercular activity of the purified compounds was evaluated by Microplate 

Alamar Blue Assay (MABA). The Compounds showed activity at 50 µg/ml and 100 

µg/ml. 

➢ Acute oral toxicity study was conducted on the Albino rats and the compounds were 

found to be safe & non-toxic. 
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CONCLUSION 

The current research work concludes that, 

1. The synthesized compounds might effectively inhibit the chosen target ATP synthase which is 

involved in the energy metabolism of Mycobacterium Tuberculosis. 

2. All the five compounds have the Docking score between 7 to -9.4 kcal/mol. There is no 

significant correlation between the score and activity of the compounds. 

3. All the synthesized compounds posses anti-tubercular activity at the concentration of 50 

µg/ml and 100 µg/ml. 

4. Therefore, further modification of the molecular structure of the compounds is expected 

to yield promising drug candidates against the deadly disease Mycobacterium 

Tuberculosis.
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